CONFIDENTIAL AND PROPRIETARY

Aries Systems Corporation

Editorial Manager®
Preprint Manager®
Commerce Manager™

Release Notification

Editorial Manager/Preprint Manager
Enterprise Analytics Reporting Feature
8.0 General Release Notification
08/18/2010
Draft – Subject to Change

Copyright © 2010, Aries Systems Corporation

This document is the confidential and proprietary information of Aries Systems Corporation, and may not be disseminated or copied without the express written permission of Aries Systems Corporation. The information contained in this document is tentative, and is provided solely for planning purposes of the recipient. The features described for this software release are likely to change before the release design and content are finalized. Aries Systems Corporation assumes no liability or responsibility for decisions made by third parties based upon the contents of this document, and shall in no way be bound to performance therefore.
### Document Change Log

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 4, 2010</td>
<td>Beta Release</td>
<td>Pg 15: Additional descriptions on Figure 18</td>
</tr>
<tr>
<td>July 12, 2010</td>
<td>Gamma Release</td>
<td>Pg 15: Additional descriptions on Figure 18</td>
</tr>
<tr>
<td>August 18, 2010</td>
<td>General Release</td>
<td>Removal of ‘Back’ button from all images</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updates to some report examples</td>
</tr>
</tbody>
</table>
**Enterprise Analytics Reporting Feature 8.0 General Release Notification**

**ENTERPRISE ANALYTICS REPORTING FEATURE**

- Main Menu Overview .................................................. 1
- Running an Existing Report .......................................... 6
- Creating a New Report, or Editing an Existing Report ........... 10
  - Tab 1: Data Sources ................................................. 13
  - Tab 2: Fields .......................................................... 15
  - Tab 3: Summary ..................................................... 26
  - Tab 4: Chart .......................................................... 28
  - Tab 5: Gauge .......................................................... 31
  - Tab 6: Misc ............................................................. 33
  - Tab 7: Style ............................................................. 36
  - Tab 8: Filters ........................................................... 39
ENTERPRISE ANALYTICS REPORTING FEATURE

Enterprise Analytics Reporting is a new reporting tool that has been integrated into the EM/PM/CM system in v8.0. Enterprise Analytics Reporting is being implemented using a third-party reporting tool from Izenda (www.izenda.com). For publications wishing to create customized reports, Enterprise Analytics Reporting will diminish the need to manipulate extracted data with external tools such as Excel, and will enable the generation of simple graphical reports such as those described below.

Although the new feature is available free of charge, it must be enabled by Aries’ Customer Service group. Once enabled, all Editors with the existing RoleManager permission ‘Produce Reports’ will see a new link on the Reports menu – Enterprise Analytics Reporting.

Figure 1 – Reports Menu (partial page)

Clicking this link leads to the Enterprise Analytics Reporting main menu page. From this menu, users can:

- Run standard reports supplied by Aries, and adjust report parameters if the report allows it.
- Run shared reports created by other users.
- Create reports and share these with other users if desired.
- Create new reports based on standard reports.
When the feature is first enabled, the Enterprise Analytics Reporting main menu provides access to a set of Standard Reports created by Aries for all publications. The Standard Reports section of the main menu has two categories of reports: Editorial Reports and Production Tracking Reports (displayed only for publications using Production Tracking). Clicking on a report name immediately runs the report and displays results based on the default criteria.

Editors may use the ‘Create Report’ link, located to the left of the report menu, to make a new report, or they may use a Standard Report as a starting point and save a customized version of the report. When reports have been created and saved by the Editor, these will also display on the main menu in their own section. Reports can be saved as individual-level reports (accessible only to the report creator) which are listed in the ‘My Reports’ section. Reports can also be shared with other users, and are listed in the ‘Shared Reports’ section.

NOTE: At upgrade, the only reports on the menu will be the Standard Reports. The ‘My Reports’ and ‘Shared Reports’ sections appear after the Editor saves their own reports, or after another Editor saves a report as a Shared Report.

TO CONFIGURE:
Enterprise Analytics Reporting is enabled by Aries’ Customer Service group. To enable this feature, please contact your customer service representative.
Main Menu Overview

The EAR Main Menu displays all available reports separated into sections. A folder icon is displayed next to each report category. Clicking this icon expands/collapses the list of reports in each category.

Figure 3 – Collapsed Reports List

![Collapsed Reports List](image1)

Figure 4 – Expanded Reports List

![Expanded Reports List](image2)

Each report name appears as a link, and clicking the link will run the report. Hovering the mouse over a report name without clicking may display one or two icons to the left:

- ‘Design’ – The ‘Design’ icon allows users to copy or edit the existing report. This icon appears for reports created by the logged in user, or saved with ‘Read Only’ or ‘Full Access’ permission (see the ‘Tab 6: Misc’ section of this document for more information on security settings).
- ‘Delete’ – The ‘Delete’ icon displays only for reports created by the logged-in Editor.

The display of these icons depends on how the report was saved (e.g. if it was saved as ‘View Only’, then no user except the report owner can edit or delete the report). Standard reports created by Aries cannot be modified or deleted by any user, but the ‘Design’ icon allows users to modify the report, to be saved as a new report.
Editors may click the ‘Design’ icon to edit a standard report and then save that report definition under a new name. The new report will save in either the ‘My Reports’ or ‘Shared Reports’ area, depending on whether the Editor has elected to share the new report with other users.

To run a report, the Editor clicks on a report name. The display format of the results page depends on the report design (see the ‘Running an Existing Report’ section of this document for more information).
Users may create a new report from scratch by clicking the Create Report link on the left side of the main menu. Clicking this link opens the report design interface. See the ‘Creating a New Report, or Editing an Existing Report’ section of this document for detailed information on creating a new report.

Figure 7 – Sample Report results page – filters at the top of the page may be used to modify the report, displayed in the table below

<table>
<thead>
<tr>
<th>Article Type</th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
<th>2009</th>
<th>2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>All New Article Types</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Abstract</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Brief Article</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Case Report Article</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Clinical Trial</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Clinical Paper</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Commentary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Letter</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>News Item</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Original Study</td>
<td>5</td>
<td>16</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Report</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rapid Communication</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Review</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Comments</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Total</td>
<td>27</td>
<td>25</td>
<td>124</td>
<td>27</td>
<td>8</td>
<td>5</td>
<td>21</td>
<td>12</td>
<td>19</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 8 – Initial Design Report page
Running an Existing Report

When the Editor clicks a report name from the main menu, the report will run and display the results page. The results page may be configured to display any or all of the following:

1. A chart – displays a graphical depiction of the data being reported (for example, a bar chart, pie chart, etc.)
2. A gauge (speedometer-style graphic) – used for a ‘dashboard’-type display of the data to help visualize critical performance data
3. A summary report – provides a high-level summary of the information being reported in a table format
4. A detailed report – provides a detailed display of the information reported in a table format

Each element is configured on its own tab in the ‘Design’ view. See the ‘Creating a New Report, or Editing an Existing Report’ section of this document for more information on these report elements.

Figure 9 – Sample Report with Chart

When the results are returned, there is a toolbar at the top of the page with options for the user to download the report, edit the report, or go back to the main menu.
• The ‘Report List’ option returns the user to the EAR main menu.

• There are a number of options available for downloading the report results:
  o Print – Prints the results page to a PDF file. When the file is ready, a dialog box displays allowing the user to save the PDF to disk or open and print it immediately.
  o Downloads the results in comma separated value (CSV) format.
  o Downloads the results in OpenOffice document (SXW) format.
  o Downloads the results in Microsoft Excel format.
  o Downloads the results in Microsoft Word format.
  o Downloads the results in an XML document.
  o Downloads the results in Rich Text Format (RTF) format.

• The Results filter allows users to limit the number of records displayed on the results page. This should be set to ‘All’ to ensure that all data is returned, though the number of rows presented may be limited to 1, 10, 100 or 1000.

The Editor can modify the report by clicking the ‘Design’ button on the toolbar (if the report was saved so that it can be modified). The report can also be modified by hovering over the report name on the Enterprise Analytics Reporting main menu and clicking the icon.

Reports are usually limited to certain data sets (for example, submissions in the current year) using Filters. The report designer decides whether the filter can be changed when the report is run, for example to change the date range that the report covers. If the report contains a Filter that can be changed when running the report, the Filter(s) display at the top of the report results page (similar to the way ‘Search People’ works). The Editor can change the filter temporarily (for example, change Reviewer Stop Date – In Time Period – In the Past, to Reviewer Stop Date – In Time Period – Previous Year).
To see the results with the change applied, the Editor may need to click the ‘Update Results’ button.

The Editor may also use the ‘Add Field’ and ‘Delete Field’ drop-down lists to temporarily add or delete fields to the information displayed in the report results, for example to add an additional piece of information before downloading results. The ‘Add Field’ drop-down displays all fields in the View(s) or Table(s) from which the report was created. The ‘Delete Field’ drop-down displays the fields currently selected to display on the report (fields selected on the ‘Fields’ tab when the report was created and any fields added by the Editor using the ‘Add Field’ drop-down).

NOTE: Not all fields available in the ‘Add Field’ drop-down may be applicable to the report as designed.

NOTE: Adding or deleting a field in this way affects the detail report results only.

If the Editor wishes to permanently save the new report layout, the Editor must click the ‘Design’ button (the changes are retained) and then click the ‘Save’ button to re-save the report with the new selections, or click the ‘Save As’ button to save the report under a new name.

NOTE: Some reports may be saved with a permission that does not allow other Editors to save changes. See the ‘Tab 6: Misc’ section of this document for more information on report permissions.
NOTE: Fields added or deleted are displayed temporarily, and are discarded in the event the ‘Back’ or ‘Report List’ buttons are clicked. To retain changes to use the modified report again and again, users must click the ‘Design’ button, and then ‘Save’ or ‘Save As...’.

Figure 14 – Saving an Edited Report
Creating a New Report, or Editing an Existing Report

Editors may develop new reports by either creating a new report, or modifying an existing report.

- Create a new report by clicking the Create Report link from the Enterprise Analytics Reporting main menu.
- Edit an existing report by clicking the ‘Design’ icon next to the report name on the menu, or by clicking the ‘Design’ button from the report results page.

Reports are created with the following basic steps:

- Select the database tables or views that contain the desired information. This may require multiple tables/views that will need to be linked together when building the report.
- Define one or more elements for displaying the data. Reports typically contain a detailed report, plus one other supporting summary, chart or gauge.
- Define the filters required to limit the data results returned in the report.
- Format the report and provide titles and descriptions.

When creating a new report or editing an existing report, the Editor is brought to the Report Designer interface. This interface displays a series of tabs used by the report designer to create or modify the report.

- Data Sources – Select your data source (tables or views) from the available list. More than one table or view may be selected. This is a required step.
- Fields – Select the fields to be displayed on the Detailed Report. Available fields are those included in the table(s) and/or view(s) selected on the ‘Data Sources’ tab. This step also allows complex grouping, arithmetic and Pivot Table functionality to be applied to the data. This step is optional, though at least one of the four key areas (Fields, Summary, Chart, Gauge) should be configured for a report. Each of these four areas is independent, with separate field selections for each.
- Summary – Select the fields to be displayed on the Summary Report. Available fields are those included in the table(s) and/or view(s) selected on the ‘Data Sources’ tab. This is an optional step, though at least one of the four key areas (Fields, Summary, Chart, Gauge) should be configured for a report. Each of these four areas is independent, with separate field selections for each.
- Chart – Configure a chart to display information graphically, in a chart format selected from plot, bar, pie, trend, funnel. This is an optional step, though at least one of the four key areas (Fields, Summary, Chart, Gauge) should be configured...
for a report. Each of these four areas is independent, with separate field selections for each.

- **Gauge** – Gauges can be used to build ‘dashboard’-type displays and help users visualize critical performance data. This is an optional step, though at least one of the four key areas (Fields, Summary, Chart, Gauge) should be configured for a report. Each of these four areas is independent, with separate field selections for each.

- **Misc** – Add a Report Title, Report Description, Report Header and Report Footer. This is also where permissions are determined (whether this is a shared report, available to all users, etc.). This is an optional step, though it is recommended that a title and short description be entered for the report.

- **Style** – Change the colors of the report, the display order of the elements (Detail Report, Summary Report, Chart, Gauge), and other layout elements. This is an optional step.

- **Filters** – Use this tab to set up search criteria for the reports. For example, use this tab to set up specified date ranges for a search, or to limit a report to a specific term (such as a specific Editor decision term). This is an optional step, though most reports will require one or more filters to exclude unwanted data.

- **Preview** – This tab allows the report results to be viewed during the design process, without leaving the report design interface. Each tab also has a ‘Preview’ button that brings the designer to the ‘Preview’ tab.

**Figure 15 – Report Design Toolbar**

Below the row of tabs is the report designer toolbar containing some additional items not displayed on the Report viewer toolbar:

- **New** – Allows report designers to create a new report.

- **Save** – Saves changes to the existing report under the same name.  
  NOTE: This button is not available for all reports, such as a standard report. It is available for all users where a report is saved with ‘Full Access’ permission. See the ‘Tab 6: Misc’ section for more information on permissions.

- **Save As...** – Allows the report designer to save a copy of the report under a new name. To save a modified version of a standard report; click the ‘Design’ button, make edits, then use this button to save a copy.

- **SQL** – Allows to the report designer to download the SQL query for the report as a text file.
Each tab of the report design process allows the report designer to configure aspects of the report. Not every tab is required to create a successful report, though there needs to be at least one element of the report configured (Fields, Summary, Chart, or Gauge) in order to see any results on the page.
Tab 1: Data Sources

When creating a new report, the ‘Data Sources’ tab is selected by default. This tab is where the report designer selects a database table or a custom report View (a pre-joined set of database tables) from the list of available Views and Tables. At upgrade to v8.0, this list contains all Views from ‘Custom Reports’ and a subset of Tables available in ‘General Data Export’.

- As with General Data Export, Tables are available even if the publication is not using the feature (e.g. Commerce Manager Tables are available). These Tables will not contain any data if the publication is not using the feature.

This is a required step. The report designer will not be able to access the other tabs to design the report until at least one table or view has been selected.

Figure 17

Enterprise Analytics Reporting allows the report designer to build reports from more than one Table or View at a time, a function not available with General Data Export or Custom Reports. This function is similar to exporting multiple tables from General Data Export and joining them in Excel, except that they are joined in the Enterprise Analytics Reporting tool (which will often join the Tables automatically within the reporting interface). This allows the report designer to create a report using fields from multiple
Tables with the values displayed in the report results instead of having to export the data to Excel.

- To insert another View or Table, click the arrow icon next to the drop-down list, and select an additional Table or View from new drop-down list.
- If the Tables/Views have a common field, the reporting tool will attempt to identify the correct field that links the first table to the second. The report designer should double-check that the tool has selected the best field to use in linking the tables, and select other fields if necessary.

**Figure 18 – Sample of joined Tables**

If the report designer is editing an existing report, Tables and/or Views will have already been selected on the Data Sources tab. This selection can be changed by selecting a different Table/View from the drop-down, or added to by inserting new rows and selecting new tables in the list.

NOTE: Changing or deleting a table may affect the Fields, Summary, Chart, Gauge, and Filters tabs.

Information about database Tables can be obtained from the General Data Export page, by clicking the Get more help link. Information about Custom Report Views can be obtained from the Custom Report page, by clicking the ‘New Report’ button and clicking the Get more help link.
Tab 2: Fields
After selecting the Tables/Views from the Data Sources tab, the report designer clicks the ‘Continue to Fields’ button or the ‘Fields’ tab to move to the Fields selection page. This page is where the report designer selects the fields that will be used for the detailed report.

The detailed report displays in a spreadsheet-like table, listing the selected fields (one field per column), but the detail report allows much more complex analysis, through:

- Visual Grouping, splitting the detail report into multiple tables, grouped under selected ‘visual group’ fields
- Functional Grouping, permitting a subtotal function to be applied to data under a group (this is not directly linked to visual grouping)
- Arithmetic functions, allowing simple functions (addition, subtraction, multiplication, division)
- Pivot Table functionality, breaking down data under selected column groupings

Figure 19
The ‘Records’ box allows the report designer to limit the number of results that are returned in the Detail report.

NOTE: In most cases, the report designer will not want to limit the number of results, in which case the Records box should be empty.

This ‘Field’ selector contains a drop-down list of all the fields that are available from the Tables and Views selected on the Data Sources tab. The report designer can select any field contained in these Tables or Views from the drop-down list. The description entered in the ‘Description’ field will display as the column name on the report, but the report designer may change the description of the field if desired.

The designer then has several checkbox options for display and manipulation of the values in the field:
• Sort – selecting this checkbox sorts the report results by the field’s value. The default sort is ascending. To change the sort to descending, the report designer must click the Advanced Field Settings icon and select the checkbox Sort (z-a) from the Advanced field setting popup.

Figure 20 – Advanced Settings popup display

• VG (Visual Grouping) – selecting this checkbox causes this field to be displayed as a sub-header on the report, and all results related to the sub-header are shown underneath. Selecting multiple fields will result in the data grouped by sub-heading of all fields with VG checked/selected. Example: A report listing people and classifications could be visually grouped by the classification field. Each classification name will show up as a sub-header on the results, with all the people having that classification listed underneath, followed by another Classification sub-header with people, etc. Further grouping by Reviewer Role (for example), displays groupings by like Classification and Reviewer Role (see Figures 20 and 21). Visual Grouping automatically sorts by the fields selected.
A (Arithmetic operation) – selecting this checkbox allows the report designer to perform addition, subtraction or division of two adjacent fields. When the box is clicked, an arithmetic operator (such as +) will appear. To change the operator, continue clicking in the box. Set the operator on the second field in the desired equation. Place the desired description on the first field. The results page will display the first field’s value [+/-/*/] the second field’s value. In the example shown below, the Reviewer’s ‘Total Number of Completed Reviews’ will be subtracted from the ‘Total Number of Invitations’ to provide the number of invitations where the Reviewer did not complete a review.
The report designer may also use a Function or Pivot to summarize and analyze the data.

There are two main types of Function:

- Group functions allow the report designer to specify the way the data is to be arranged for applying a summary function
- Summary functions provide subtotals, averages or other summaries within the specified groupings

As an example, users may wish to have a report that simply lists a count of submissions, with one Article Type per row in a simple table. Selecting the ‘Group’ function for the ‘Article Type’ field will return one row per Article Type in the results. To then have a count of how many submissions are assigned each Article Type, the report designer would select a summary function (such as ‘Count’ function on Unique Document ID), to get the count to display for the Article Type group.
To view another example, the standard report ‘Accept and Reject Decisions by Editor in selected timeframe’ uses the ‘Final Decision Term’ field in three different ways: One row uses ‘Group’ to group all like terms (so there is one row for each term), one row uses ‘Count’ to count the number of records with the displayed decision term, and one row uses ‘Count’ in conjunction with the format column (see below) to display the percentage of the total decisions this displayed decision represents.

- The values available in the ‘Function’ drop-down box depend on the type of field being displayed.
  - If a text field is selected, the choices are ‘Group [group the results by this value and show all unique results], Count [count the number of results with a value in this field], and Count Distinct [count the number of results with a unique value in this field, eliminating duplicates from the count].
  - If a date field is selected, additional choices are added; for example Group (Day) [groups results by day], Group (Year) [groups results by year], Group (Month) [groups results by month], etc.
  - If an integer/numerical field is selected, the choices include: Average [calculates the mean average of the values], Maximum [displays only the maximum value], Minimum [displays only the minimum value], Sum [sums the values], Sum Distinct [increments the count once for each unique value, ignoring duplicates], etc.
- It is not necessary to select anything from the ‘Function’ drop-down box, however, if ‘Function’ is used for any field, a selection must be made for all fields.

NOTE: The ‘Group’ functions can be combined with selection as a Visual Group.
Similar summary functionality is provided by the Pivot functionality described below.

The ‘Format’ drop-down box is used to determine how the field will display. Example: The standard report ‘Accept and Reject Decisions by Editor in selected timeframe’ uses the ‘Final Decision Term’ field with the ‘Count’ function on one row with no display format. The same field is repeated with a ‘Count’ function and displayed with the format ‘% of Group (with rounding)’. When the report is run, the first field row displays as a column with the number of each decision term, and the second field row displays as a column with the percentage of all decisions with that term.

The values in the ‘Format’ drop-down box depend on the type of field being displayed.

A selection does not need to be made in the ‘Format’ drop-down box.

TIP: The […] option will not apply any special formatting to a field, normally resulting in the default format of e.g. 1,000 for integers.

The following icons are displayed to the right of the ‘Format’ drop-down box:

- □ – Deletes the field row from the selected list
- □ – Inserts a field row below the current row
- □ – Inserts a field row above the current row
- ● – Advanced Field Settings: Opens a popup window allowing additional parameters to be selected. As mentioned, this is where the Editor can change the sort order from ascending to descending. See below for additional information on this popup.
- ▲ – Change Field Order: Clicking this icon and holding down the mouse allows the report designer to drag the field above or below other fields, to change the field order.
The Advanced Field Settings popup contains a number of settings that can be designated for the specific field (row) rather than the report as a whole.

Figure 27 – Sample view of Advanced Field Settings popup

The settings include:

- **Hide this field** – allows the field to be hidden from the reports. An example may be if the results are to be sorted by a field, but that field is not required for the report results.
- **Sort (z-a)** – when a field is used for sorting a report, this option allows the sort order to be changed.
- **Italic** – displays the results in this column in italics
- **Bold** – displays the results in this column in bold
- **Width** – allows the report designer to designate a fixed column width in pixels. NOTE: If the Width entered is narrower than the length of the column label, the column label width will take precedence.
- **Label Justification** – sets whether the column labels are Right, Middle, or Left justified. The default is Middle. Clicking the box rotates through the options.
- **Value Justification** – sets whether the values in the columns are Right, Middle, or Left justified. The default is blank, which left-justifies text fields and right-justifies number fields. Clicking the box rotates through the options.
• **Subreport** – Used to select a ‘drill-down’ report.

Drill-down reports are used as a method of running a report from within a report by connecting two reports together on a common field.

Two reports are created to use the Drill-down feature: A detailed, or subreport, and the calling report, which will look to the subreport. A report intended for use as a Detailed report is designated as such on the ‘Misc’ tab (see ‘Tab 6: Misc’ for more information on this setting).

To link the field on the calling report to the detailed report, the report designer includes the linked field on the ‘Fields’ tab of the calling report, and selects the desired detailed subreport in this ‘Subreport’ field.

When the calling report is run, the results in the linked field are returned with a hyperlink to the detailed report (or embedded data from the detailed report, depending on the selected style below). Clicking the hyperlink returns results from the detailed report for the specified value only.

• **Drill-Down Style** – when a subreport is selected, this option defines how the drill-down report results display:
  - **Link** – links to the resulting record from the detailed report in the same window and navigates the user from the original report.
  - **Link (New Window)** – links to the resulting record from the detailed report in a new window.
  - **Embedded** – embeds the linked record from the detailed record into the cell in the report table.
  - **Popup** – links to the resulting record from the detailed record in a popup located on the same page.

• **Url** – used to link to a specific page in the system. This field is typically not used.

• **Subtotal Function** – used in conjunction with the ‘Add Subtotals’ checkbox (see below).

• **Text Highlight** – defines a color in which the result text displays, such as ‘green’ or ‘blue’.

• **Cell Highlight** – defines a color in with the cell background displays, such as ‘red’ or ‘yellow’.
The checkbox ‘Add Subtotals’ allows the report designer to automatically add subtotals to the bottom of each report column that contains numbers. Click the ‘Advanced Field Settings’ icon next to each field that will be subtotaled to further refine how the subtotal will be calculated using the ‘Subtotal Function’ field (e.g. Count, Count Distinct, etc.), or to suppress the subtotal for that field.

The following buttons display below the field grid:

1. Quick Add – opens a popup window listing all available fields allowing the report designer to select multiple fields at once.
2. Add Pivot – allows the report designer to add an additional level of information to the report.

- A Pivot automatically groups and summarizes data, in a similar fashion to setting up a group manually using the Function drop-downs.

- When adding a Pivot, the group values are displayed in columns rather than rows, with the summary displayed below the column.

**Figure 30 – ‘Add Pivot’ example**

- First select a field in the “Add pivot columns for” drop-down.

- Select a function (as described in the Function section above) to apply to this field. The available options are dependent on the selected field. In the above example, the Article Type field will be grouped together, so that there will be one column displayed for each Article Type.

- Select a field to be used in the calculation, then select the function to apply to that calculation and the format to be applied to the results.

For example, in the Article Type grouping example above, instead of selecting the Article Type as a Field and applying a Group function to it (which would create a report with each Article Type as a separate row), select Article Type under the ‘Add Pivot Columns for’ with a Group operation, then select the ‘Unique Document ID’ field with the function ‘Count Distinct’ to create a report with one column per Article Type.

**NOTE:** The report designer needs to select at least one field in the main table (or create a Summary Report on the ‘Summary’ Tab), and the data will automatically be grouped by that category in rows plus the Article Type in columns.
3. Continue to Summary – allows the report designer to go to the Summary tab. The report designer can alternatively click on the ‘Summary’ tab instead of using this button. See below for more information on the ‘Summary’ tab.

4. Preview – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.
Tab 3: Summary

A Summary Report is a slightly simpler version of the Details report created on the Fields tab. Use this report for a simple list of submissions, or to apply grouping or summary functions to those lists for simple subtotals. The arithmetic, visual grouping, and Pivot functions are not available for Summary reports. This step is optional.

Figure 32

The ‘Title’ box allows the report designer to enter a title specifically for the Summary Report. This will be displayed for this summary, and may be different from the general report title entered on the ‘Misc’ tab.

The ‘Records’ box allows the report designer to limit the number of results that are returned in the Summary report.

NOTE: In most cases, the report designer will not want to limit the number of results, in which case the Records box should be empty.

As with the ‘Fields’ tab, the report designer chooses the fields to appear in the summary report by using the ‘Fields’ drop-down list, adds a description, enables sorting (if desired), chooses a function, and selects the format (see ‘Tab 2: Fields’ for full information).

Two checkboxes display under the field grid:

- Add Subtotals – When this is checked/selected, subtotals are generated for all columns that use numbers. To control the exact calculation of the subtotal of a given field, click the ‘Advanced Field Settings’ icon for that row and make a selection from the ‘Subtotal’ drop-down list. The report designer may also leave the subtotal choice at ‘Default’, and the system will use the most logical subtotal for the field.

- Add Deltas – When checked/selected, the system generates the difference between the value in one row and the value in the next row in all columns that contain numerical values. Example: This can be used to calculate the difference between the number of submissions received in one year versus the following year.
The following buttons display:

1. **Continue to Chart** – allows the report designer to go to the ‘Chart’ tab. The report designer can alternately click the ‘Chart’ tab instead of using this button.

2. **Preview** – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.
Tab 4: Chart
This Chart step is optional, and is used if the report designer wants to include a chart or graph with the report. The standard report ‘Accept and Reject Decisions by Editor in selected timeframe’ displays an example of a bar chart display.

Figure 33

The first step is to select a Chart type. The following types are available:

- **Trend** – displays a plot of the results in the shape of a line graph.

- **Pie** – displays the results as a pie chart. When ‘Pie’ is selected from the drop-down list, additional options are available such as ‘Explode largest slice’ (separate the largest slice from the rest of the pie), ‘Show Percentage’ (show the chart as percentages of the total instead of raw numbers), etc.

- **Plot** – similar to Trend, but the individual results (plot points) are not connected by a line.

- **Bar** – displays the results as a bar graph. Additional parameters are available when ‘Bar’ is chosen.

- **Funnel** – displays the results in the shape of a funnel (typically used for illustration in reporting).

**NOTE:** The results are not sorted by default, so in order to make this chart meaningful, the results should be sorted from largest to smallest.
Depending on which type of Chart is selected, additional selections may be configured for the chart. These may include:

- **Title** – allows the report designer to enter a title to appear over the chart. This will be displayed for this chart, and may be different from the general report title entered on the ‘Misc’ tab.

- **Records** – allows the report designer to limit the number of results that are used to build the chart.
  
  NOTE: In most cases, the report designer will not want to limit the number of results, in which case the Records box should be empty.

- **Label** – allows report designer to use the drop-down to select the horizontal (X) axis labels (categories) for the report. The ‘Average Days to Decision by Editor’ report uses the ‘Last Name of the Editor who made First Decision’ field as the value in this drop-down.

- **Value** – allows report designer to use the drop-down to select the value that is being graphed. The ‘Average Days to Decision by Editor’ report uses the ‘Days with Editor’ field with an ‘Average’ function. This will display the average days to decision per Editor on the graph.

- **Separator** – displayed for some chart types. If displayed, it allows the report designer to further subdivide the results. The ‘Average Days to Decision by Editor’ report uses the ‘Final Decision Term’ field to break down the average days with Editor by decision.

- **Show legend** – when selected, shows the chart legend to the right side of the chart.

- **Show as 3D** – shows each slice of a Pie chart in 3D.

- **Explode largest slice** – shows the largest slice of a Pie chart as separated from the other slices.

- **Show Percentage** – adds % labels for each slice of a Pie chart.

- **Show Value Labels** – adds labels to the values. Available for a Trend chart and Pie chart.

- **Show Slice Labels** – adds labels for each slice of a Pie chart.

- **Show Pareto** – adds a cumulative trend line above a bar chart, and adds a right axis with % of total identified.

- **Smooth** – smooths out a trend chart (line graph), so that the line appears curved rather than spiky.

- **Connect** – connects the lines of a Plot chart, making it similar to a Trend chart.

- **Chart Type** – a pie chart can be displayed as a full pie (like a pizza) or as a doughnut with a hole in the center.
• Label Title (Bottom) – allows the report designer to add text for the horizontal label (X) axis.

• Value Title (Left) – allows the report designer to add text for the vertical value (Y) axis.

• Target Report – if a report is created with a drill-down field enabled (see ‘Tab 6: Misc’ for more information), and that field is included in the chart results, then clicking the relevant chart segment will drill-down to the underlying report.

The following buttons display:

• Continue to Gauge – allows the report designer to go to the ‘Gauge’ tab. The report designer can alternately click the ‘Gauge’ tab instead of using this button.

• Preview – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.

**Figure 34 – Sample Graph report showing Number of Submissions received per month**

![Sample Graph report showing Number of Submissions received per month](image)
Tab 5: Gauge
This step is optional, and is used if the report designer wants to create a gauge (speedometer-type chart). The standard Production Tracking report ‘Average days to complete production task’ displays a gauge on the results page.

Figure 35

The following selections are available for configuring the gauge:

- **Title** – allows the report designer to enter a title for the gauge(s).
- **Results** – limits the number of gauges displayed.
- **Name** – allows the report designer to select a label for the gauges from the list of available fields (based on the selected Data Sources). In the example above, the Name is ‘Submission Production Task Name’, where each gauge will be labeled with the name of a Submission Production Task.
- **Value** – allows the report designer to select the value to appear in the gauge from the list of available fields (based on the selected Data Sources). In the above example, ‘Days between Submission Production Task Assignment and Task...’
Completion’ is the value, with the ‘Average’ function used to calculate an average number of days for each Submission Production Task.

- **Sort** – allows the report designer to determine which results (gauges) appear first based on the selected sort field. The default sort is ascending (smallest to largest), to sort descending (largest to smallest), select the checkbox Sort (z-a).

- **Minimum and Maximum** – allows the report designer to determine the smallest and largest value shown on the gauge.

- **Gauge Style** – allows the report designer to select the appearance of the gauge:
  1. Radial (speedometer style)
  2. Radial 2 (alternative speedometer style)
  3. Linear (ruler style)

The following buttons display:

1. **Continue to Misc** – allows the report designer to go to the ‘Misc’ (Miscellaneous) tab. The report designer can alternately click the ‘Misc’ tab instead of using this button.

2. **Preview** – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.
Tab 6: Misc
The Misc step is optional. It allows the report designer to enter a Title, Header and Footer for the report. It also allows configuration of “Share With” rights and the selection of a Drill-Down Key.

Figure 37

The following options are available:

- **Title** – allows the report designer to enter a title for the report as a whole. This is the title that displays on the Main Menu.
- **Description** – allows the report designer to enter a report description that is displayed underneath the report title on the results page.
- **Header** – allows the report designer to enter a header that appears above the report Title on the results page.
- Footer – allows the report designer to enter a footer that appears below the last table of results.

- Share With – always set to 'Everyone'. For the EM/PM implementation of the EAR, the only available option is ‘Everyone’.

- Rights – allows the report designer to determine whether this is a shared report, and whether other users may make changes. The default setting for new reports is ‘None’. The options are:

  1. None – saves the report under the report designer’s 'My Reports' area of the EAR main menu. No other user can view or resave the report. The report designer can click the 'Design' button to make changes to the report and save the changes to the same report (using the 'Save' button), or to a new report (using the 'Save As' button).

  2. Full Access – saves the report under the 'Shared Reports' area of the EAR main menu. Other users can click the 'Design' button to change the report, and can save changes to the underlying report using the 'Save' button or use the 'Save As' button to save changes to a new report. NOTE: Using the ‘Save’ button will overwrite the existing report. Allowing Full Access to the report may result in other users saving changes over the original report.

  3. Read Only – saves the report under the 'Shared Reports' area of the EAR main menu. Other users can view the results and click the 'Design' button to make changes and then use the 'Save As' button to save the report under a new name. Only the report designer sees the 'Save' button to save changes to the base report.

  4. View Only – saves the report under the 'Shared Reports' area of the EAR main menu. Other users can view the results, but cannot resave the report under a new name. The 'Design' button is suppressed on the Report Viewer toolbar.

NOTE: Standard reports can never be edited, but a copy can be saved under new name and the copy can be changed.

- Drill-Down Key – the drop-down box lists all fields available for the report (based on the selection in the Data Sources tab). Making a selection in this drop-down allows this detailed report to be ‘linked’ to a different calling report, using a field common to both reports. When the report viewer clicks the common field in the top-level report, they can see the results of the lower-level report. See the ‘Tab 2: Fields’ section for more information on designating the link between the calling report and the subreport (detailed report).

  1. NOTE: The Aries-created standard reports that are configured with a Drill-Down Key are indicated with the word ‘Subreport’ in their report name.

  2. Example: The standard report ‘People Detail Sheet Subreport’ uses the ‘People Unique ID’ field as a Drill-Down Key. When the Editor runs the
standard reports ‘People and Institutions’ or ‘People and Classifications’, the ‘People ID- drill down’ column appears on the results page, with each People ID as a clickable link. Clicking a People ID brings up a popup window with the portion of the ‘People Detail Sheet Subreport’ that is relevant to that particular People ID.

**Figure 38 – Sample of Drill-down report**

The following buttons display:

1. Continue to Style – allows the report designer to go to the ‘Style’ tab. The report designer can alternately click the ‘Style’ tab instead of using this button.
2. Preview – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.
**Tab 7: Style**

The Style step is optional. It allows the report designer to enter custom colors, set pagination, and minimize the appearance of the report on the screen.

**Figure 39**

The following options are available:

- Border color/Header color/Header foreground color/Item color/Item foreground color/Alternating item color – allows the report designer to select custom colors.
for each of these areas on the report results. When selected, the ‘Sample grid’ (shown below the ‘Restore Default’ button) reflects the color selections as a preview for the report designer.

- **Restore Default button** – allows the report designer to reset all the colors to the default colors, and reflects the default colors in the Sample Grid.

- **Sample Grid** – reflects the color selections and functions as a preview of the report results display.

- **Checkboxes** – a series of options, including:
  
  - Landscape printing: Determines the orientation of the report when printed to a PDF.
  - Show page number: If selected, the page number displays at the top of each page when printed to a PDF.
  - Show date and time: If selected, the date and time the report was printed appears at the top of each printed page.
  - Use pagination in web view: When a report is run where this is selected, the report displays pagination links on the results page (1-100, 101-200, etc.) to enable users to navigate through the result set.
  - Add bookmark for each visual group: When Visual Grouping is used (see the ‘Tab 2: Fields’ section), bookmarks for each section are generated on the left side of the PDF.
  - Page Break After Visual Groups: When Visual Grouping is used (see the ‘Tab 2: Fields’ section), each Visually Grouped set of data appears on a separate page in the PDF.
  - Minimize Grid Width: Allows the report to take up the minimum amount of space on the screen, instead of expanding to fill the whole screen. Tip: this is a good choice for a report with gauges, as it will cause the gauges to wrap if selected rather than expand the page and require horizontal scrolling to see the results.

- **Visual Group style**
  
  - This choice is applied if the checkbox ‘VG’ was selected for a field (on the Fields tab). It governs the display of the visual group sub-headers.

- **Items per page (in Viewer)**
  
  - An integer value may be entered here. It governs how many rows are listed on the results page before a new page is created (causing the pagination links to be displayed).

- **Report Order**
  
  - The report designer can designate the order in which the Chart, Gauges, Summary report and Detail report are shown on the results page. These
sections can be re-ordered by using the move up (↑) and move down (↓) icons.

- **Field|Value column pairs**
  - The values 1 through 4 can be selected from this drop-down box.
  - This choice governs how many columns of field/value pairs appear on the results page. Example: Choosing 4 from the drop-down box causes 8 columns to appear on the results page – 4 field name columns and 4 associated value columns.
  - NOTE: To apply this setting, one of the two checkboxes below must also be selected.

- **Show main report in Field|Value style** – causes the Field|Value column pairs configuration to be applied to the main (not summary) report.

- **Show summary report in Field|Value style** – causes the Summary report (if any) to be displayed using the Field|Value column pairs configuration.

**Figure 40 – Sample Display; 2 column pair selected above**

The following buttons display:

1. **Continue to Filters** – allows the report designer to go to the ‘Filters’ tab. The report designer can alternately click the ‘Filters’ tab instead of using this button.

2. **Preview** – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.
**Tab 8: Filters**

The ‘Filters’ tab controls which records will display in the final report. This step is optional, though typically used to limit the data returned. It allows the report designer to filter (limit) the report results based on the value of any field available for the report. This page is similar to the existing *Search Submissions* page.

NOTE: Configuring a filter on this page applies the filter to all the report results – the main report, summary report, chart and gauges.

The following options are available:

- **Filter Field** – a drop-down list allowing the report designer to select any field available for the report (per the ‘Data Sources’ tab).
  
  Note: The field does not need to have been selected on the Fields tab, and does not need to appear on the results page.

  - **Operator** – the report designer can designate whether the Filter Field is greater than a value, equals a value, is within a designated time period (such as ‘Last Year’ or ‘In the past’), contains certain text, equals multiple values, doesn’t equal multiple values, equals one value [Equals (select)], doesn’t equal one value [Doesn’t Equal (select)], etc.

  - **Values** – depending on the selection in the Operator field, the Value column allows the report designer to either type in a value, or select from a list of values. Making a selection here limits the report to results that match the value (or don’t match the value, depending on the operator). Leave the value set to […] to search for any value. When combined with the Parameter setting (below), this allows the end-user to select the parameters rather than setting a pre-determined value to be used.

  NOTE: To combine multiple filters, the filters should be configured first, and combined using the ‘Filter Logic’ entry box (see below).
- Blank – select this box to return results with the value of blank (null).
- Parameter – selecting this checkbox causes the filter configuration to be displayed on the report results page. The user running the report can change the filter and click the ‘Update Results’ button on the toolbar to see the results with the new filter.
  
  **NOTE:** When filters are applied to a report, they do not display at the top of the ‘Preview’ page. They will only appear at the top of the Report results when the report is run, not previewed.

- Icons – The standard delete \( \times \), add field above \( \uparrow \), add field below \( \downarrow \), and move \( \uparrow \downarrow \) icons are displayed.

- **Show Filters in Report Description** – selecting this checkbox displays the values of each filter used to generate the report in the report’s descriptive text, but does not allow the user to change the filters. To allow the user to change the filters, select the ‘Parameter’ checkbox next to each filter you want the user to be able to change.

- **Require drop-down box** – making a choice in this drop-down box requires the end user to select a value for at least one, the first, or the first two filters when running the report.
  
  **NOTE:** To cause a filter to appear to the end user, the ‘Parameter’ checkbox must be selected for the filter.

- **Filter Logic** – to combine the filters in any way other than simple ‘AND’ logic, the report designer must type the filter logic into the box. For example, to combine three filters so that a result must match both filter one and two OR match filter three to appear in the results, the report designer would type: \((1 \text{ AND } 2) \text{ OR } 3\) (using the filter numbers). Parentheses and OR can also be used, as shown in the example above.

The following button displays:

1. **Preview** – clicking this button generates a preview of the report results page, without saving the report. The report designer can alternatively click the ‘Preview’ tab instead of using this button.